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           Financial Guideline 2024/2025  

    
Financial Year-End 2024/2025  

     

1. Overview of Financial Year end 2024 / 2025  

   

The annual accounts must be prepared using the latest version of the FSSU chart of accounts 

(September 2024) which is available here on our website. These codes will be effective for the Year 

ended August 2025 and it is important to compare the current list of nominal codes in your school’s 

accounts package with this latest chart of accounts to ensure that both are in alignment.   

    

There were a few new grants in 2024/2025, and the accounting treatments are outlined in the 

guidelines detailed in the table below. It is important that these grants are recorded correctly in 

Sage 50 and that any unspent ringfenced grants are adjusted into the relevant balance sheet codes 

at the year end.   
 

        Guideline No.  Topic  Overview  

41 – 2024/2025 Funding scheme for mobile phone storage 

solutions 

Ringfenced 

40 – 2024/2025 Special Class Grants Ringfenced 

39 – 2024/2025 ICT Grant 24/25 Ringfenced 

32 – 2024/2025  Free Schoolbooks scheme & Admin grant 

25/26  

Paid in advance & 

Ringfenced  

20 – 2024/2025  Science Implementation Grant (25/26) Paid in Advance & 

Ringfenced  

12 – 2024/2025  Solar Panels & Micro Generation payments 

  

Ringfenced  

03 – 2024/2025  Accounting for Junior Cycle Schoolbooks 

Scheme Grant 24/25 

Ringfenced  

 

1a. Key accounting treatment from Guideline 03 – 24/25   

Junior Cycle Free Schoolbooks Scheme & Admin Grant for the 24/25 school year 

    

The new Junior Cycle Schoolbooks Scheme provides free schoolbooks for all children and young 

people in Junior Cycle years in recognised post-primary schools in the free education scheme.  

This scheme includes all schoolbooks and core classroom resources. This scheme was introduced 

in the 2024/2025 school year.   
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The Junior Cycle Schoolbooks Scheme Grant and the Administration Support Grant received in the 

2023/2024 financial year were for the school year 2024/2025 and were recorded as a grant received 

in advance. While any related expenditure incurred in 23/24 was treated as a prepayment.  

 

It is important that these balances are adjusted from the Balance Sheet to the Income and 

Expenditure Account at 1.9.2024 and any unspent amount at 31.8.2025 should be recorded as 

unspent at that date.   

  

1.b  Key accounting treatment from Guideline 32 – 24/25   

Free Schoolbooks Scheme & Admin Grant for the 25/26 school year 

  

The Post-primary Schoolbooks scheme was extended for the 25/26 school year to cover all years 

in the post-primary schools in the free education scheme. It was paid in advance therefore: 

 

•  These grants must be accounted for as a grant received in advance in Sage 50.   

• Any expenditure of this grant before the end of the 2024/2025 school year should be recorded 

as a prepayment.  

 

1.c  Key accounting treatment from Guideline 20 – 24/25   

    Science Implementation Grant for the 25/26 school year 

This funding is aimed at supporting the rollout of revised leaving cert science subjects for the 

next financial year 25/26 as part of the Senior cycle redevelopment. 

It is paid in advance so therefore: 

• The grant must be accounted for as a grant received in advance in Sage 50.   

• Any expenditure of this grant before the end of the 2024/2025 school year should be recorded 

as a prepayment.  

 

2. Summary of key deadlines:   

   

The school should aim to supply all financial information to their external accountant/auditor for 

the school year ending 31st August 2025 by September 30th, 2025. Other key deadline dates to 

be aware of are:  

Date  Action   

30th September  
The board provides all financial information to the external accountant for the 

school year August 31st        

10th October  The necessary audit adjustments should be inputted into Sage 50 if available and the 

Year End must be run in Sage 50 to facilitate appropriate BOM reporting for the new 

Financial Year.  
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If the adjustments are not available, please run the year end at this date and the 

relevant journal adjustments for Year-end (dated 31.8.2025) can be recorded in the 

relevant Balance sheet codes in Sage 50.  

30th November  The draft annual accounts are returned by the accountant.   

31st December  Accounts are reviewed and approved by the board and signed by the chairperson 

and one other board member.   

28th February  
Accountant submits the accounts to the FSSU and uploads a pdf copy of the 

approved annual accounts.   

  

Sage 50 Accounts Upgrade & Version 32  

  

Most of the Voluntary Secondary Schools have upgraded and are availing of the remote data 
access and Bank feeds features available with the software. The FSSU strongly advise the setting 
up of remote data access for your Accountant as it will enhance the efficiency of the school 
accounts preparation process at the end of the financial year. Your accountant will also need to 
have upgraded their Sage software to the same version in order to access your data.  
Your accountant will be required to have Sage 50 Client manager and use the same version of Sage 
as the school in order to access the school data. 
  
It is advisable to check the version of Sage under Help / About and ensure that it is the latest 

Version 32. There are instructions for upgrading here in our Sage 50 section of the website.  

Year-end procedure in Sage 50 must be processed by October 10th, 2025  

To run the BOM reports for the new year which includes the budget for 2025/2026 and prior year 

figures, the Financial Year End must be run in Sage 50. We would suggest that the latest date for 

running the Year end in Sage should be October 10th, 2025, to ensure that the board of 

management receive all the definitive reports for the new financial year. There will be webinar 

training available to assist with finalising the Year End figures in Sage 50. Click here for upcoming 

training webinars.  

3. Preparation for Year End 2024 / 2025  

It is important that school’s chart of accounts is in alignment to the revised FSSU Chart of accounts 

so therefore it is advised to compare the current list of nominal codes in your schools Sage 50 with 

the revised FSSU chart of accounts to check for any inconsistencies. A current revised FSSU Chart 

of accounts is available here on our website. This will facilitate the inputting of the accounts into 

the FSSU Online accounts submission system by your external accountant/auditor and reporting 

of financial information to the Department and to the Charities Regulator.  

  

https://www.fssu.ie/post-primary/topics/sage-50-accounts/sage-version/
https://www.fssu.ie/post-primary/topics/sage-50-accounts/training/training-videos/bank-feeds/
https://www.fssu.ie/post-primary/topics/sage-50-accounts/training/webinar-training/upcoming-sage-50-webinars/
https://www.fssu.ie/post-primary/topics/sage-50-accounts/training/webinar-training/upcoming-sage-50-webinars/
https://www.fssu.ie/post-primary/topics/sage-50-accounts/training/webinar-training/upcoming-sage-50-webinars/
https://www.fssu.ie/post-primary/topics/chart-of-accounts/
https://www.fssu.ie/post-primary/topics/chart-of-accounts/
https://www.fssu.ie/post-primary/topics/chart-of-accounts/
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• In finalising the year-end 31st August 2025, you should post all day-to-day transactions for the 

year. This ensures that your management reports and year-end postings are as accurate as 

possible. We have created a comprehensive checklist below to help you ensure that all 

transactions are recorded, and all accounts are reconciled. Please note not all of these will 

apply to you.    

   

• It would be advisable to prepare a file for the external accountant/auditor with a copy of 

relevant documents.   

  

The key steps for preparing and completing the Year end in Sage 50 are as follows:   

 

Step 1: Complete the following checklist:   

 

                                        Before Running the Year-End 2024/2025:  Done  

1. Post all day-to-day transactions for the year. This ensures that your management reports 

and year end postings are accurate. Ideally any audit adjustments from the accountants 

should be posted to the income and expenditure codes within a reasonable time frame.  

  

2. Ensure you have bank statements for all school bank accounts covering the period 1st 

September 2024 to 31st August 2025 and ensure all bank accounts are reconciled up to 

31st August 2025.   

  

3. Review the bank reconciliation report as follows:  

a. Review the list of outstanding payments and receipts on the bank reconciliation to 
ensure they are accurate.   

b. Any duplicate entries should be Identified and written off. 

c. Any outstanding payments/receipt more than six-months-old should be 
investigated.  

  

4. Ensure that the petty cash and credit card transactions are recorded for the year and that 

the balances in the petty cash and credit card account are correctly stated at the end of 

the year.  

  

5. Ensure that the balance in the Cash Control Account equates to the amount of cash and 

cheques held in the safe on 31st August 2025.  
  

6. Ensure that the balance in the online payment solution clearing account (code 1870) 

equates to the amount of money owed from the online payments company at the 31st 

of August 2025.  

  

7. Payroll records: Print individual employee payroll records for the period 1st September 

2024 to 31st August 2025, print copy of the payroll summary for the 2024 year and have 

a backup of the payroll saved to a memory stick for 2024 and up to 31st August 2025.   

  

8. The PAYE/PRSI/USC/LPT control account (nominal code 2250) should equate to the 

PAYE/PRSI/USC/LPT that is owed to Revenue at 31st of August 2025. (Where payroll 

journals are utilised).  

  

9. The net wages control account (code 2200) should be zero or any balance explained.    
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10. Other wage related control account balances (e.g., Union Fees, Single Public Pension 

Scheme, ASC) should equate to amounts owed at 31st August 2025 (if recording payroll 

using the payroll journal).  

  

11. VAT: Review ROS to ensure all VAT returns are filed. Remember you must file VAT returns 

even if liability is Nil.  

The VAT control account (nominal code 2260) should equate to the VAT that is owed to 

Revenue at 31st of August 2025 (if using VAT journals).  

  

12. RCT: Ensure all deductions made from Subcontractors for RCT purposes have been 

returned to Revenue.  
  

 

The RCT control account (nominal code 2270) should equate to the RCT that is owed to 

Revenue at 31st of August 2025.  

 

13. Parents Association: Ensure all financial documentation is made available to the school’s 

external accountant/auditor for inclusion in the annual financial accounts of the school.   
  

14. Complete a manual list of creditors on 31st August 2025 (money owed by the school).   

If using the purchase ledger print an outstanding creditors list at 31st August 2025.   

• Match the creditor/supplier balance on the report to the statement received (or 

unpaid invoice if no statement available) from the supplier.  
• Any difference between the balance on the report and the statement should be 

investigated.   

• Any negative balances on the outstanding creditor list report should be investigated 

to see if any purchase invoices have not been posted. Request copy invoices from the 

suppliers and process on Sage 50.  

  

15. Complete a manual list of debtors & prepayments at 31st August 2025 (money owed to 

the school).   

If using the sales ledger print an outstanding debtors list at 31st August 2025.  

• Match the customer balances on the report to the statements sent to the customer.   

• Any negative balances on the outstanding customer list report should be investigated 

to see if any sales invoices have not been posted.    

  

16. Income received in the current year (2024 / 2025), for the next school year (2025/2026) 

should be shown as income received in advance on the balance sheet code 2105. Use 

the department function to analyse the various types within the nominal account. This 

will facilitate the running of a nominal activity report by department for code 2105 at 

31.08.2025 for audit purposes.   

  

17. Alternatively, complete a manual list of income/grants received by the school in the year 

2024/2025 that relate to 2025/2026 school year e.g., book grant, transition year charges, 

school administration charges, voluntary contribution.   
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18. Review the grants for the year to ensure that all grants received for the next academic 

year have been included in the accounts as ‘Grants Received in Advance (nominal codes 

2150-2152).   

  

19. Ensure that the Free Schoolbooks Scheme Grant and the Administration Support Grant 

received in the 2024/2025 financial year for the 2025/2026 financial year are recorded 

in code 2151. While the related costs should be in code 1720.  

  

20. Review the income and expenditure for ring fenced grants/income and carry any unspent 

amounts forward as unspent grants/income. See Appendix 1 for further information.  

  

21. Run a Nominal Activity Report and review the posting of transactions, to ensure they are 

accounted for correctly.  
  

22. Year-end Adjustments for creditors, debtors and income received in advance should be 

posted to SAGE 50 at 31.08.2025 before running year end if possible.  
  

  

Step 2: Print out the recommended financial reports as at 31.8.2025  

  

Reports                                                           To Run Reports  

Trial Balance  Nominal codes > Trial Balance  
Nominal codes > Reports > Trial Balance  

Balance Sheet  Nominal codes > Reports > My nominal code reports >BOM Balance Sheet  

  

Profit & Loss  Nominal codes > Reports> My nominal code reports>BOM Income & 
Expenditure Account  
  

Nominal Activity  Nominal codes > Reports> Nominal Activity  

  

Unreconciled 

Payments / Receipts  
Bank accounts > Reports > Unreconciled transactions  

  

Aged creditors report  
(only for schools using 

the Supplier module)  

Suppliers > Reports > Aged creditors > Aged creditors summary   
Suppliers > Reports > Aged creditors > Aged creditors detailed Suppliers 

> Reports > Activity > supplier activity detailed  

Aged debtors report  
(only for schools using 
the Customer module)  

  

Customers > Reports > Aged debtors > Aged debtors analysis summary   
Customers > Reports > Aged debtors > Aged debtors analysis detailed 
Customers > Reports > Activity>customer activity detailed  
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Department Report  

  
           Code 2105  

Departments > Reports > Nominal Analysis > Nominal Department analysis 
detailed > nominal code 2105 and 2105, let department default, select 
appropriate dates  
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Step 3: Managing the Year End in Sage 50  

 

 3.a Keep Sage 50 up to date for the new financial year 

Sage 50 has a soft year end, and this means you can post into your new financial year before 

running the Year End option. It is important to make sure the transaction date is correct.   

A message advises that the date is outside the current financial year, click Ok or Yes.  

The following reports can be run for the new financial year until you run the year end - 

Transactional Profit and Loss, Transactional Balance sheets and Transactional Trial Balances 

reports. Please note these reports are for internal/office use and should not be used for Board of 

Management meetings.   

 

3.b Work with the accountant to finalise accounts and year end adjustments 

Schools should liaise with their external accountants/auditors and request them to review the 

school accounts as soon as possible and to return a draft Trial Balance which will include any 

changes to the income and expenditure for the year. The necessary audit adjustments can be 

inputted into Sage 50 before processing year end and the Income and Expenditure figures 

appearing in the archived accounts will substantially agree to the signed Financial Statements at 

31.8.2025. If there are further changes after processing the year end, the adjustments can be made 

to the Balance Sheet codes dated 31.08.2025.  

3.c  Latest date for running Year end in Sage 50 is October 10th 2025 

To run the BOM reports for the new year which includes the budget for 2025/2026 and prior year 

figures, the Financial Year End must be run in Sage 50. Therefore, this year-end process cannot be 

put off for audit adjustments for too long into the new Financial Year.   

 

We recommend that the latest date for running the Year end in Sage should be October 10th, 

2025, to ensure that the Board of Management receive all the definitive reports for the new 

financial year. Please contact us if you are unable to run your year end at this time. 

 

3.d  Take two system backups 

Take A Minimum of TWO Backups and save to two separate locations (external hard 

drive/Network). Name it ‘Before Year End’- it is essential to back up the data before running the 

year end, as this is the only way to go back to a pre-year position.   
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Please see Section G for running your year end in Sage 50. Further information or clarification on 

any of the issues raised in this Guideline can be obtained from the FSSU.   

 

3.e Running the Financial Year End  

• Change the program date-change the program date to be the last day of the financial year. e.g., 

31st August 2025.  

• Take TWO backups labelled ‘Before Year End’- it is essential to back up the data before running 

the year end, as this is the only way to go back to a pre-year position. It is advisable to take two 

backups as a precaution against loss or damage of the backup media.  

• To run the Year End, select Tools > Period End > Year End.   

• This will display the year end window and complete all the steps.  

• Archive Data – select the option to archive data. This will enable you to view old data without 
having to restore old backups.   

• Check the details shown at the bottom of the Year End window are correct before selecting 
the Run Year End option.   

• Click YES if the Year End dates are correct.   

• A year end progress screen will appear. Once complete you will be asked if you would like to 
print the Year End journal. Click ok.  

• A final message appears that the financial year end has been completed, click OK.  

3.f   Check Data After Running the Year End   

• Run a Brought Forward trial balance. Select Modules > Nominal codes > Trial Balance for the 
period select Brought Forward  

• Make sure there are no income and expenditure codes on this report  

• Next, Check your data again. File > Maintenance > check Data  

• Finally take another backup of the data and label it ‘After Year End’  

• Do NOT clear the audit trail. However, if there are more than two years accounts data on Sage 
50 and if Sage processing appears to be slowing down then clearing the audit trail should be 
considered. Please refer to our Year end  Sage 50 section of the website for details on this process.  

Full details on running the year end are in ‘FSSU SAGE Accounts Manual -Section 8’   

4. The school Budget for 2025/2026 should now be imported into Sage 50    

  There is an excel sheet included in the Budget Template 2025/2026 called “Sage 50 Import” which 

provides a summary of the nominal codes and the total budget figures for the year.  

The details in Column A, B & D of this sheet can be copied into a template available in Sage 50, and 

this will enable the budget data to be imported into Sage 50.   

https://www.fssu.ie/post-primary/topics/sage-50-accounts/
https://www.fssu.ie/post-primary/topics/sage-50-accounts/
https://www.fssu.ie/app/uploads/2017/07/FSSU-SAGE-Accounts-Manual.pdf
https://www.fssu.ie/app/uploads/2017/07/FSSU-SAGE-Accounts-Manual.pdf
https://www.fssu.ie/app/uploads/2017/07/FSSU-SAGE-Accounts-Manual.pdf
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See our website here for guidance on the process. Please ensure that your budget import 

template has the same nominal codes as exist in your Sage 50 accounts and that a backup is 

taken before importing the information.   

5. Audit adjustments  

Once the year end is run, any audit adjustments for the 2024 / 2025 Accounts should be dated 

31.08.2025 and should only be made to Balance Sheet codes with Income and Expenditure 

adjustments recorded in the Revenue Reserves code 2710.  

6. Prior year comparatives  

  For those schools who want their Income and Expenditure Account showing the prior year, year 
to date comparatives instead of the full prior year, this optional report along with the instructions 
on how to copy into Sage 50 are available on the Getting started in Sage 50 section of our 
website.  

7. Sage 50 Training  

We are running some live webinar training sessions from August - October to supplement and 

support this Guideline by providing guidance on preparing for and finalising the year end in Sage 

50.  

All these planned webinars will build on the supply of FSSU demand videos for Sage 50 which 

are available on our website. In addition to the Sage videos there is an enhanced section on our 

website (click here) which has a variety of training video resources for new accounts personnel 

training which will enhance their knowledge of school accounts preparation.  

The FSSU will continue to provide ongoing support and training to ensure Schools are using the 

software to its maximum potential and will continue to assist schools with the new features in 

Sage 50 Accounts. In particularly we encourage the use of bank feeds as this will enhance the 

efficiency and timeliness of the accounts function while the remote data access allows for 

authoriser users from school management to have real time access to the school financial data.   

  

Tel: 01-269 0677   

info@fssu.ie   

  

26th August 2025  

  

 

 

https://www.fssu.ie/post-primary/topics/sage-50-accounts/entering-the-budget-in-sage-50/sage-budget-2/
https://www.fssu.ie/post-primary/topics/sage-50-accounts/entering-the-budget-in-sage-50/sage-budget-2024-2025/
https://www.fssu.ie/post-primary/topics/sage-50-accounts/upgrading-to-sage-50cloud/schools-new-to-sage-50/
https://www.fssu.ie/post-primary/topics/sage-50-accounts/upgrading-to-sage-50cloud/schools-new-to-sage-50/
https://www.fssu.ie/post-primary/training/training-resources-for-new-accounts-personnel/
https://www.fssu.ie/post-primary/training/training-resources-for-new-accounts-personnel/
https://www.fssu.ie/post-primary/training/training-resources-for-new-accounts-personnel/
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Appendix 1   

Accounting for Unspent Ringfenced Grants/Income  

  
Some grants/incomes are received for a specific purpose, for example the ICT grant and the 

supervision & substitution grant. These are known as ringfenced grants. The unspent portion 

of these grants should be deferred until it is spent by the school.  

  

The portion of unspent ringfenced grant balances must be accounted for at the end of the year 

using the relevant balance sheet code/s (2160-2180) in the chart of accounts.   

  

The following grants are examples of ringfenced grants.  

  

• Free Schoolbooks Scheme grant, Supervision and Substitution grant, ICT grant, Non-

teacher Pay grant, Bus Escort grant, Schools Meal grant, all capital grants, etc.  

  

To account for the unspent grants, follow the steps below:  

  

▪ Step 1: Calculate the amount of the grant unspent at the 31.08.2025 (Income Less 

Expenditure).  

  

▪ Step 2: Post a journal dated 31.08.2025 to transfer the unspent element to the balance sheet.   

  

▪ Step 3: Post a journal dated 01.09.2025 to transfer the unspent element back to the Income 

& Expenditure report for use in the 31.08.2026 year. This journal can be recorded as soon as 

possible in Sage 50 as it is date driven. 

  

  Click here for a worksheet to assist with the accounting of unspent grants.  

  

https://view.officeapps.live.com/op/view.aspx?src=https%3A%2F%2Fwww.fssu.ie%2Fapp%2Fuploads%2F2025%2F08%2FSample-template-for-manual-reports-VSS-Aug-2025.xlsx&wdOrigin=BROWSELINK
https://www.fssu.ie/app/uploads/2024/09/Calculation-of-unspent-grants-template-2024-Sage.xlsx
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Table 1  
Example of Accounting for unspent grant  

  

  

 

 

 

     Grant  

Step 1  Step 1  Step 1  Step 2  Step 3  

Income  
  

Expenditure  
  

Balance of 
Grant at  

31.08.2025  
  

Journal Unspent 
amount at  

31.08.2025  
  

Journal amount at  
01.09.2025  

  

Nominal 

Code  
Amount  Nominal 

Code  
Amount  Amount  Dr 

Code  
Cr Code  Dr Code  Cr Code  

Science implementation 

grant (2150) 

 

Related costs (1720) 

    22,000 

 

 

2,000 

  2150 

 

 

4390 

3245 

 

 

1720 

Junior cycle schoolbooks 

scheme 24/25 

3151 €75,000 4731 €70,000 €5,000 3151 2160 2160 3151 

Junior cycle schoolbooks 

admin support grant 

24/25 

3152 €2,500 4113 €2,000 €500 3152 2160 2160 3152 

Senior Cycle Book 

Grant 24/25 
3150  €9,600  4730  €8,900  €700  3150  2160    

Supervision & 

Substitution Grant  
3240  €5,130  4150  €4,200  €930  3240  2170  2170  3240  

School Library Books 

Capital Grant  
3155  €15,000  4641  €1,000  €14,000  3155  2161  2161  3155  

Bus Escort Grant  3294   4196     3294  2171  2171  3294  

DSP School Meals  3296   4912     3296  2171  2171  3296  

Digital Strategy/ICT 

Grant (Non-Capital)  
3230  €27,500  4410  €17,500  €10,000  3230  2165  2165  3230  

Digital Strategy/ICT 

Grant (Capital)  
3921  €27,500  1461  €17,500  €10,000  3921  2165  2165  3921  

Digital Divide Grant 

(Non-Capital)  
3230  €20,000  4410  €17,500  €2,500  3230  2179  2179  3230  

Digital Divide Grant 

(Capital)  
3921  €20,000  1461  €17,500  €2,500  3921  2179  2179  3921  

Capital Grant Building  3900  €90,000  3940  €80,000  €10,000  3900  2171  2171  3900  

Capital Grant: 

Equipment  

3920  €25,000  1421  €20,000  €5,000  3920  2171  2171  3920  
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           Treoirlíne Airgeadais 2024/2025  

    
Deireadh na Bliana Airgeadais 2024/2025  

     

8. Forléargas ar Dheireadh na Bliana Airgeadais 2024 / 2025  

   

Ní mór na cuntais bhliantúla a ullmhú leis an leagan is déanaí de chairt cuntas FSSU (Meán Fómhair 

2024) atá ar fáil ar ár suíomh gréasáin anseo . Beidh na cóid seo i bhfeidhm don bhliain dar críoch 

Lúnasa 2025 agus tá sé tábhachtach liosta reatha na gcód ainmniúil i bpacáiste cuntasaíochta do 

scoile a chur i gcomparáid le cairt seo na gcuntas athbhreithnithe is déanaí lena chinntiú go dtagann 

siad lena chéile.   

    

Bhí roinnt deontas nua ann in 2024/2025, agus leagtar amach na modhanna cuntasaíochta sna 

treoirlínte atá sonraithe sa tábla thíos. Tá sé tábhachtach go dtaifeadtar na deontais seo i gceart i 

Sage 50 agus go ndéanfaí aon deontais imfhálaithe gan chaitheamh a choigeartú i gcóid an chláir 

chomhardaithe ábhartha ag deireadh na bliana.   
 

        Treoirlíne 

Uimh.  

Ábhar  Forbhreathnú  

41 – 2024/2025 Scéim maoinithe do réitigh stórála fón póca Imfhálaithe 

40 – 2024/2025 Deontais Ranga Speisialta Imfhálaithe 

39 – 2024/2025 Deontas TFC 24/25 Imfhálaithe 

32 – 2024/2025  Scéim na Leabhar Scoile Saor in Aisce agus 

Deontas Riaracháin 25/26  

Íoctha roimh ré agus 

Imfhálaithe  

20 – 2024/2025  Deontas um Fheidhmiú na hEolaíochta 

(25/26) 

Íoctha roimh ré agus 

Imfhálaithe  

12 – 2024/2025  Íocaíochtaí le haghaidh Painéil Ghréine agus 

Micreaghiniúna 

  

Imfhálaithe  

03 – 2024/2025  Cuntasaíocht maidir le Deontas do Scéim na 

Leabhar Scoile don tSraith Shóisearach 24/25 

Imfhálaithe  

 

1a. Príomhchur chuige cuntasaíochta ó Threoirlíne 03 – 24/25   

Scéim na Leabhar Scoile Saor in Aisce don tSraith Shóisearach agus Deontas Riaracháin 

don scoilbhliain 24/25 

    

  

Treoirlíne  Airgeadais 2025/2026 
05 

Meánscoileanna Deonacha 

https://www.fssu.ie/post-primary/topics/chart-of-accounts/
https://www.fssu.ie/post-primary/topics/chart-of-accounts/
https://www.fssu.ie/post-primary/fssu-guidelines/current-guidelines/
https://www.fssu.ie/post-primary/fssu-guidelines/current-guidelines/
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Soláthraíonn Scéim nua na Leabhar Scoile don tSraith Shóisearach leabhair scoile saor in aisce do 

gach leanbh agus do gach duine óg atá i mblianta na Sraithe Sóisearaí in iar-bhunscoileanna a 

ghlacann páirt sa scéim saoroideachais.  

Áirítear gach leabhar scoile agus croí-acmhainn don seomra ranga sa scéim. Tugadh an scéim seo 

isteach sa scoilbhliain 2024/2025.   

Is don scoilbhliain 2024/2025 a bhí Deontas Scéim na Leabhar Scoile don tSraith Shóisearach agus 

an Deontas Tacaíochta Riaracháin a fuarthas sa bhliain airgeadais 2023/2024, agus taifeadadh iad 

mar dheontais a fuarthas roimh chaitheamh. Caitheadh le haon chaiteachas gaolmhar a tabhaíodh 

in 23/24 mar réamhíocaíocht.  

 

Tá sé tábhachtach go ndéantar na hiarmhéideanna seo a choigeartú ón gClár Comhardaithe go dtí 

an Cuntas Ioncaim agus Caiteachais amhail an 1.9.2024 agus ba cheart aon mhéid neamhchaite 

amhail ar an 31.8.2025 a thaifeadadh mar mhéid neamhchaite amhail ar an dáta sin.   

  

1.b  Príomhchur chuige cuntasaíochta ó Threoirlíne 32 – 24/25   

Scéim na Leabhar Scoile Saor in Aisce agus Deontas Riaracháin don scoilbhliain 25/26 
  

Tá síneadh curtha le Scéim na Leabhar Scoile d'Iar-Bhunscoileanna don scoilbhliain 25/26 chun 

gach bliain in iar-bhunscoileanna sa scéim saoroideachais a chlúdach. Íocadh roimh ré é dá bhrí 

sin: 

 

•  Ní mór cuntas a thabhairt ar na deontais seo mar dheontas a fuarthas roimh ré in Sage 50.   

• Ba cheart aon chaiteachas den deontas seo roimh dheireadh na scoilbhliana 2024/2025 a 

thaifeadadh mar réamhíocaíocht.  

 

1.c  Príomhchur chuige cuntasaíochta ó Threoirlíne 20 – 24/25   

    Deontas d'Fheidhmiú na hEolaíochta don scoilbhliain 25/26 

Tá an maoiniú sin dírithe ar thacú le cur i bhfeidhm ábhair athbhreithnithe eolaíochta na 

hardteistiméireachta don chéad bhliain airgeadais eile, 25/26, mar chuid d’athfhorbairt na 

sraithe Sinsearaí. 

Íoctar roimh ré é dá réir: 

• Ní mór cuntas a thabhairt ar an deontas sin mar dheontas a fuarthas roimh ré in Sage 50.   

• Ba cheart aon chaiteachas den deontas seo roimh dheireadh na scoilbhliana 2024/2025 a 

thaifeadadh mar réamhíocaíocht.  

 

9. Achoimre ar na príomh-spriocdhátaí:   

   

Ba cheart don scoil gach iarracht a dhéanamh an fhaisnéis airgeadais uile maidir leis an scoilbhliain 

dar críoch an 31 Lúnasa 2025 a sholáthar dá cuntasóir/dá hiniúchóir seachtrach faoin 30 Meán 

Fómhair 2025. Is iad na príomh-spriocdhátaí eile nach mór a bheith ar an eolas fúthu ná:  

Dáta  Gníomh   
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30 Meán 

Fómhair  
Cuireann an bord an fhaisnéis uile airgeadais ar fáil don chuntasóir seachtrach don 

scoilbhliain faoin 31 Lúnasa 

An 10 Deireadh 

Fómhair  
Ba cheart na coigeartuithe iniúchta riachtanacha a ionchur in Sage 50 agus ní mór 

Deireadh na Bliana a rith in Sage 50 chun tuairisciú BOM cuí don Bhliain Airgeadais 

nua a éascú.  

Mura bhfuil na coigeartuithe ar fáil, déan an próiseas deireadh bliana a rith ar an 

dáta sin agus is féidir na coigeartuithe ábhartha leabhair chúnta do dheireadh na 

bliana (dar dáta 31.8.2025) a thaifeadadh sna cóid ábhartha don Chlár 

Comhardaithe in Sage 50.  

30 Samhain  Cuireann cuntasóir isteach na dréachtchuntais bhliantúla.   

31 Nollaig  Déanann an bord na cuntais a athbhreithniú agus a cheadú agus síníonn an 

Cathaoirleach iad, mar aon le ball amháin eile den bhord.   

28 Feabhra  
Cuireann an cuntasóir na cuntais isteach chuig an FSSU agus uaslódálann cóip PDF 

de na cuntais bhliantúla cheadaithe.   

  

Uasghrádú Sage 50 Accounts & Leagan 32  

  

Tá an chuid is mó d’Iar-bhunscoileanna Deonacha tar éis uasghrádú a dhéanamh agus tá leas á 
bhaint acu as rochtain ó chian ar shonraí agus ar na gnéithe a bhaineann le fothaí Bainc atá ar fáil 
leis an mbogearra. Molann an FSSU go láidir cianrochtain sonraí a chur ar bun do do Chuntasóir 
mar gheall go gcuirfidh sé le héifeachtúlacht an phróisis ullmhúcháin cuntas scoile ag deireadh na 
bliana airgeadais. Beidh ar do chuntasóir a bhogearra Sage a uasghrádú go dtí an leagan céanna 
freisin chun rochtain a fháil ar do shonraí.  
Ní mór go mbeidh Sage 50 Client Manager a bheith ag do chuntasóir agus an leagan céanna de 
Sage atá ag an scoil a úsáid chun rochtain a fháil ar shonraí na scoile. 
  
Moltar an leagan Sage a sheiceáil faoi Help / About agus a chinntiú gurb é an Leagan 32 atá á úsáid 

agat. Tá treoracha maidir le huasghrádú anseo i rannóg Sage 50 dár suíomh gréasáin.  

Ba chóir nós imeachta deireadh bliana in Sage 50 a phróiseáil faoin 10 Deireadh Fómhair, 2025  

Chun tuarascálacha an Bhoird Bhainistíochta a rith i gcomhair na bliana nua, lena n-áirítear an 

buiséad le haghaidh 2025/2026 agus figiúir na bliana roimhe sin, ní mór Deireadh na Bliana 

Airgeadais a rith in Sage 50. Moltar gurb é an dáta is déanaí chun an próiseas Deireadh Bliana a 

rith in Sage an 10 Deireadh Fómhair, 2025 chun a chinntiú go bhfaighidh an Bord Bainistíochta na 

tuarascalacha cinntitheacha go léir don bhliain airgeadais nua. Reáchtálfar seimineár gréasáin 

chun cabhrú le clabhsúr a chur ar fhigiúirí Deireadh Bliana in Sage 50. Cliceáil anseo le haghaidh 

seimineáir ghréasáin oiliúna atá le teacht.  

https://www.fssu.ie/post-primary/topics/sage-50-accounts/sage-version/
https://www.fssu.ie/post-primary/topics/sage-50-accounts/training/training-videos/bank-feeds/
https://www.fssu.ie/post-primary/topics/sage-50-accounts/training/webinar-training/upcoming-sage-50-webinars/
https://www.fssu.ie/post-primary/topics/sage-50-accounts/training/webinar-training/upcoming-sage-50-webinars/
https://www.fssu.ie/post-primary/topics/sage-50-accounts/training/webinar-training/upcoming-sage-50-webinars/


16  

  

10. Ullmhú do Dheireadh na Bliana 2024/2025  

Tá sé tábhachtach go mbeadh Cairt Cuntas na scoile i gcomhréir le Cairt na gcuntas 

athbhreithnithe FSSU; mar sin, moltar an liosta reatha cód ainmniúil in Sage 50 do scoile a chur i 

gcomparáid le Cairt athbhreithnithe na gCuntas FSSU chun aon neamhréireachtaí a d’fhéadfadh a 

bheith ann a aimsiú. Tá cóip reatha de Chairt Cuntas FSSU athbhreithnithe ar fáil ar ár suíomh 

gréasáin anseo . Éascóidh sin obair do chuntasóra/d’iniúchóra seachtraigh agus iad ag ionchur na 

gcuntas i gcóras taiscthe cuntas ar líne FSSU, agus ag tuairisciú faisnéis airgeadais don Roinn agus 

don Rialálaí Carthanas.  

  

• Sula gcuirtear an próiseas deireadh bliana dar críoch an 31 Lúnasa 2025 i bhfeidhm, ba cheart 

na hidirbhearta uile ó lá go lá i gcomhair na bliana a bhreacadh. Ar an mbealach sin, is féidir a 

áirithiú go bhfuil do chuid tuarascálacha bainistíochta agus na rudaí a bhreacfar ag dheireadh 

na bliana cruinn. Tá seicliosta cuimsitheach cruthaithe againn thíos chun cabhrú leat a chinntiú 

go ndéantar gach idirbheart a thaifeadadh, agus go réitítear na cuntais go léir. Tabhair faoi 

ndeara go mb’fhéidir nach mbainfeadh gach ceann acu leat.    
   

• Moltar duit comhad a ullmhú don chuntasóir/iniúchóir seachtrach, mar aon le cóip de na 

doiciméid ábhartha.   

  

Seo a leanas na príomhchéimeanna chun deireadh na bliana a ullmhú agus a chur i gcrích in 

Sage 50:   

 

Céim 1: Déan na nithe ar an seicliosta seo a leanas:   

 

                                        Roimh an bpróiseas Deireadh Bliana a Rith le haghaidh 

2024/2025:  

Déanta  

1. Déan na hidirbhearta uile ó lá go lá i gcomhair na bliana a bhreacadh. Ar an mbealach sin, 

is féidir a chinntiú go bhfuil do chuid tuarascálacha bainistíochta agus breacadh 

dheireadh na bliana cruinn. B’fhearr aon choigeartuithe ó na cuntasóirí a bhreacadh leis 

na cóid Ioncaim agus chaiteachais laistigh de thréimhse ama réasúnta.  

  

2. Áirithigh go bhfuil ráitis bhainc agat maidir le cuntais uile na scoile, lena gcumhdaítear an 

tréimhse ón 1 Meán Fómhair  2024 go dtí an 31 Lúnasa 2025 agus áirithigh freisin go 

bhfuil na cuntais bhainc go léir réitithe suas go dtí an 31 Lúnasa 2025.   

  

3. Déan athbhreithniú ar an tuarascáil imréitigh bainc mar seo a leanas:  

d. Féach ar liosta na n‑íocaíochtaí amuigh agus na bhfáltas ar an ráiteas imréitigh 
bainc lena chinntiú go bhfuil siad cruinn ceart.   

e. Ba chóir aon iontrálacha dúblacha a thabhairt faoi deara agus iad a scriosadh. 

f. Ba cheart gach íocaíocht/fáltas atá níos sine ná sé mhí d’aois a iniúchadh.  

  

4. Áirithigh go ndéantar na hidirbhearta mionairgid agus cárta creidmheasa a bhreacadh síos 

i gcomhair na bliana agus go luaitear na hiarmhéideanna sa chuntas mionairgid agus 

carta creidmheasa i gceart ag deireadh na bliana.  

  

https://www.fssu.ie/post-primary/topics/chart-of-accounts/
https://www.fssu.ie/post-primary/topics/chart-of-accounts/
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5. Cinntigh go bhfuil an t-iarmhéid sa Chuntas Rialaithe Airgid i gcomhréir le méid an airgid 

thirim agus na seiceanna atá á gcoimeád sa taisceadán ar an 31 Lúnasa 2025.  
  

6. Cinntigh go bhfuil an t-iarmhéid sa chuntas imréitigh íocaíochtaí ar líne (cód 1870) i 

gcomhréir leis an méid airgid atá dlite ón gcuideachta íocaíochtaí ar líne amhail ar an 31 

Lúnasa 2025.  

  

7. Taifid phárolla: Déan taifid phárolla a phriontáil do na fostaithe faoi leith don tréimhse ón 

1 Meán Fómhair 2024 go dtí an 31 Lúnasa 2025, déan cóip den achoimre párolla don 

bhliain 2024 a phriontáil agus bíodh cóip chúltaca den phárolla sábháilte agat ar 

mhéaróg chuimhne le haghaidh 2024 agus suas go dtí an 31 Lúnasa 2025.   

  

8. Ba cheart gurbh ionann an méid sa chuntas rialúcháin ÍMAT/ÁSPC/MSU/CMÁ (cód 

ainmniúil 2250) agus an méid ÍMAT/ÁSPC/MSU/CMÁ atá dlite do na Coimisinéirí Ioncaim 

amhail ar an 31 Lúnasa 2025. (Sa chás go mbaintear úsáid as irisí párolla).  

  

9. Ba chóir gurbh ionann an cuntas rialúcháin glanphá (cód 2200) agus náid, nó más ann 

d’iarmhéid, ba chóir é a mhíniú.    

10. Aon iarmhéideanna eile i gcuntais rialúcháin a bhaineann le pá (m.sh. táillí 

ceardchumainn, Scéim Pinsin Poiblí Aonair, Ranníocaíocht Aoisliúntais Bhreise), ba 

cheart gurbh ionann iad agus na méideanna dlite amhail ar an 31 Lúnasa 2025 (más rud 

é go bhfuil an párolla á thaifeadadh tríd an leabhar cúnta párolla).  

  

11. CBL: Caith súil siar ar ROS lena chinntiú gur cuireadh isteach na tuairisceáin CBL go léir. 

Cuimhnigh nach mór duit tuairisceáin CBL a chomhdú fiú amháin más ionann do 

dhliteanas agus toradh nialasach.  

Ba cheart gurbh ionann an méid sa chuntas rialúcháin CBL (cód ainmniúil 2260) agus an 

méid CBL atá dlite do na Coimisinéirí Ioncaim amhail ar an 31 Lúnasa 2025 (má táthar ag 

úsáid leabhair cúnta CBL).  

  

12. RCT: Áirithigh go ndearnadh na hasbhaintí uile a baineadh ó Fhochonraitheoirí chun 

críocha RCT a thuairisciú chuig na Coimisinéirí Ioncaim.  
  

 

Ba cheart gurbh ionann an méid sa chuntas rialúcháin RCT (cód ainmniúil 2270) agus an 

méid RCT atá dlite do na Coimisinéirí Ioncaim amhail ar an 31 Lúnasa 2025.  

 

13. Cumann na dTuismitheoirí: Áirithigh go gcuirtear an doiciméadúchán airgeadais uile ar fáil 

do chuntasóir/iniúchóir seachtrach na scoile lena gcuimsiú i gcuntais airgeadais bhliantúla 

na scoile.   

  

14. Déan liosta creidiúnaithe de láimh ar an 31 Lúnasa 2025 (airgead atá dlite den scoil).   

Má úsáideann tú an mórleabhar ceannachán déan liosta a phriontáil de na creidiúnaithe 

gan íoc amhail an 31 Lúnasa 2025.   

• Meaitseáil iarmhéid an chreidiúnaí/an tsoláthraí ar an tuarascáil leis an iarmhéid ar 

an ráiteas a fuarthas ón soláthraí (nó leis an sonrasc gan íoc mura bhfuil aon ráiteas 

ar fáil).  

• Ba cheart aon difríocht idir an t‑iarmhéid ar an tuairisc agus an t-iarmhéid ar an 
ráiteas a fhiosrú.   
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• Ba cheart aon iarmhéid diúltach ar an tuarascáil de liosta na soláthraithe amuigh a 

fhiosrú le fáil amach an bhfuil aon sonrasc ceannacháin ann nár breacadh síos. Iarr 

cóipeanna de shonraisc ar na soláthraithe agus déan iad a phróiseáil ar Sage 50.  

15. Cuir liosta féichiúnaithe agus réamhíocaíochtaí i gcrích de láimh amhail ar an 31 Lúnasa 

2025 (airgead atá dlite don scoil).   

Má úsáideann tú an mórleabhar díolachán, déan liosta a phriontáil de na féichiúnaithe 

gan íoc amhail ar an 31 Lúnasa 2025.  

• Déan cinnte gurb ionann iarmhéideanna na gcustaiméirí ar an tuarascáil agus na ráitis 

a seoladh chuig na custaiméirí.   

• Ba cheart aon iarmhéid diúltach ar an tuarascáil de liosta na gcustaiméirí amuigh a 

fhiosrú le fáil amach an ann d’aon sonrasc díolacháin nár breacadh.    

  

16. Aon ioncam faighte sa bhliain reatha (2024/2025), atá ceaptha don bhliain dar gcionn 

(2025/2026), ba chóir é a thaispeáint ar an gclár comhardaithe faoi chód 2105 mar 

ioncam scoile a fuarthas roimh ré. Bain úsáid as feidhm na roinne chun anailís a 

dhéanamh ar na cineálacha éagsúla laistigh den chuntas ainmniúil. Éascóidh sé seo 

tuarascáil ghníomhaíochtaí ainmniúla a reáchtáil de réir roinne do chód 2105 amhail ag 

an 31.08.2025 chun críocha iniúchóireachta.   

  

17. Mar mhalairt ar sin, déan liosta de láimh d’ioncam/dheontais a fuair an scoil le linn a 

bliana 2024/2025 a bhaineann le scoilbhliain 2025/2026 e.g., deontas leabhar, táillí 

idirbhliana, táillí riaracháin na scoile, ranníocaíocht dheonach.   

  

18. Déan na deontais don bhliain a athbhreithniú lena chinntiú gur cuimsíodh na deontais 

uile a fuarthas don chéad scoilbhliain eile sna cuntais mar ‘Deontais a Fuarthas Roimh 

Ré’ (cóid ainmniúla 2150-2152).   

  

19. Cinntigh go ndéantar Deontas Scéim na Leabhar Scoile Saor in Aisce agus an Deontas 

Tacaíochta Riaracháin a fuarthas sa bhliain airgeadais 2024/2025 don bhliain airgeadais 

2025/2026 a thaifeadadh faoin gcód 2151. Ba cheart go mbeadh na costais ghaolmhara 

i gcód 1720, áfach.  

  

20. Déan an t-ioncam agus caiteachas a athbhreithniú maidir le haon deontais/ioncam 

imfhálaithe agus tabhair ar aghaidh aon mhéideanna nár caitheadh mar 

dheontais/ioncam gan chaitheamh. Féach Aguisín 1 chun tuilleadh faisnéise a fháil.  

  

21. Cruthaigh Tuarascáil ar Ghníomhaíochtaí Ainmniúla agus seiceáil ar breacadh síos na 

hidirbhearta go cruinn lena chinntiú gur tugadh cuntas ceart orthu.  
  

22. Ba cheart Coigeartuithe Deireadh Bliana maidir le creidiúnaithe, féichiúnaithe agus 

ioncam faighte roimhe ré a bhreacadh in SAGE 50 ar an 31.08.2025 roimh an bpróiseas 

deireadh bliana a rith más féidir.  

  

  

 

Céim 2: Priontáil amach na Tuarascálacha Airgeadais atá molta amhail ar an 31.8.2025  

  

Tuarascálacha                                                           Tuarascálacha a Rith  

Comhardú Trialach  Nominal codes > Trial Balance  

Nominal codes > Reports > Trial Balance  
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Clár Comhardaithe  Nominal codes > Reports > My nominal code reports >BOM Balance Sheet  

  

Brabús agus 

Caillteanas  

Nominal codes > Reports> My nominal code reports>BOM Income & 
Expenditure Account  
  

Gníomhaíocht 

Ainmniúil  

Cóid ainmniúla > Tuarascálacha> Gníomhaíocht Ainmniúil  

  

Íocaíochtaí / Fáltais 

Neamhréitithe  

Bank accounts > Reports > Unreconciled transactions  

  

Tuarascáil ar 

chreidiúnaithe 

aosaithe  

(le haghaidh 

scoileanna a úsáideann 

an modúl Soláthraithe 

amháin)  

Soláthraithe > Tuarascálacha > Creidiúnaithe aosaithe > Achoimre ar 

chreidiúnaithe aosaithe   

Suppliers > Reports > Aged creditors > Aged creditors detailed Suppliers 

> Reports > Activity > supplier activity detailed  

Tuarascáil ar 

fhéichiúnaithe 

aosaithe  

(le haghaidh 
scoileanna a úsáideann 
an modúl Custaiméirí 

amháin)  
  

Customers > Reports > Aged debtors > Aged debtors analysis summary   

Customers > Reports > Aged debtors > Aged debtors analysis detailed 
Customers > Reports > Activity>customer activity detailed  
  

Department Report  

  

           Cód 2105  

Departments > Reports > Nominal Analysis > Nominal Department analysis 
detailed > nominal code 2105 and 2105, fág department mar an réamhshocrú, 
roghnaigh na dátaí cuí  
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Céim 3: Deireadh na Bliana a Bhainistiú in Sage 50  

 

 3.a Sage 50 a choinneáil suas chun dáta don bhliain airgeadais nua 

Tá deireadh bliana bog ag Sage 50, rud a chiallaíonn gur féidir leat breacadh i do bhliain airgeadais 

nua sula ritheann tú an rogha Deireadh Bliana. Tá sé tábhachtach a bheith cinnte de go bhfuil dáta 

an idirbhirt ceart.   

Beidh teachtaireacht le feiceáil ina gcuirfear in iúl go bhfuil an dáta lasmuigh den bhliain airgeadais 

reatha, cliceáil ar Ok nó Tá.  

Féadfar na  tuarascálacha a leanas a rith i leith na bliana airgeadais nua go dtí go ritheann tú an 

próiseas deireadh bliana - Brabús agus Caillteanas ó Idirbhearta, Cláir chomhardaithe na 

nIdirbheart agus tuarascálacha ar Chomharduithe Trialacha na nIdirbheart. Tabhair faoi deara le 

do thoil go bhfuil na tuarascálacha sin beartaithe le haghaidh úsáid inmheánach/oifige agus nár 

cheart iad a úsáid le haghaidh cruinnithe an Bhoird Bhainistíochta.   

 

3.b Oibrigh leis an gcuntasóir chun cuntais agus coigeartuithe dheireadh na bliana a 

thabhairt chun críche 

Ba cheart do scoileanna idirchaidreamh a dhéanamh lena gcuntasóirí/lena n-iniúchóirí 

seachtracha agus a iarraidh orthu a gcuid cuntas a athbhreithniú chomh luath agus is féidir agus 

Dréacht-chomhardú Trialach a chur isteach, ina n-áireofar athruithe ar na cuntais ioncaim agus 

caiteachais don bhliain. Féadfar na coigeartuithe iniúchta a bhfuil gá leo a chur isteach i Sage 50 

sula ndéanfar deireadh na bliana a phróiseáil agus beidh na figiúir le haghaidh Ioncaim agus 

Caiteachais a bheidh le feiceáil sna cuntais arna gcur i gcartlann i gcomhréir, tríd is tríd, leis na 

Ráitis Airgeadais sínithe amhail ar an 31.8.2025. Má bhíonn tuilleadh athruithe i gceist tar éis 

próiseáil dheireadh na bliana, féadfar na coigeartuithe a dhéanamh ar chóid an Chláir 

Chomhordaithe dar dáta an 31.08.2025.  

3.c  Is é an 10 Deireadh Fómhair 2025 an dáta is déanaí is féidir an próiseas deireadh bliana a 

rith in Sage 50 

Chun tuarascálacha an Bhoird Bhainistíochta a rith i gcomhair na bliana nua, lena n-áirítear an 

buiséad le haghaidh 2025/2026 agus figiúir na bliana roimhe sin, ní mór Deireadh na Bliana 

Airgeadais a rith in Sage 50. Dá bhrí sin, ní féidir an próiseas deireadh bliana seo a chur siar rófhada 

sa Bhliain Airgeadais nua ar mhaithe le coigeartuithe iniúchta.   

 

Molaimid gurb é an dáta is déanaí chun an próiseas Deireadh Bliana a rith in Sage an 10 Deireadh 

Fómhair 2025 chun a chinntiú go bhfaighidh an Bord Bainistíochta na tuarascálacha cinntitheacha 
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go léir don bhliain airgeadais nua. Déan teagmháil linn mura bhfuil tú in ann an próiseas deireadh 

bliana a rith ag an am sin. 

 

3.d  Déan dhá chúltaca córais 

Déan DHÁ Chúltaca ar a laghad agus déan iad a shábháil in dhá shuíomh ar leithligh (tiomántán 

crua seachtrach/Líonra). Tabhair ‘Roimh Dheireadh na Bliana' mar ainm air ’ - tá sé ríthábhachtach 

cóip chúltaca a dhéanamh de na sonraí sula ndéanfar an próiseas deireadh bliana a rith, toisc gurb 

é sin an t-aon bhealach chun dul ar ais go dtí staid réamhbhliana.   

Féach ar Chuid G maidir le deireadh do bhliana a rith i Sage 50. Féadtar tuilleadh eolais nó soiléiriú 

a fháil ar aon cheann de na saincheisteanna sa Treoirlíne seo ach dul i dteagmháil leis an FSSU.   

 

3.e Próiseas Deireadh Bliana Airgeadais a Rith  

• Athraigh dáta an chláir-athraigh dáta an chláir go dtí an lá deireanach den bhliain airgeadais. 

e.g., 31 Lúnasa 2025.  

• Déan DHÁ chóip chúltaca agus cuir an lipéad ‘Roimh Dheireadh na Bliana’ orthu - tá sé 

ríthábhachtach cóip chúltaca a dhéanamh de na sonraí sula ndéanfar deireadh na bliana a rith, 

toisc gurb é sin an t-aon slí chun dul ar ais go dtí staid réamhbhliana. Moltar dhá chóip chúltaca 

a dhéanamh mar réamhchúram ar eagla go ndéanfaí damáiste do na meáin chúltaca nó go 

gcaillfí ceann díobh.  

• Chun an próiseas Deireadh Bliana a rith, roghnaigh Tools > Period End > Year End.   

• Ansin taispeánfar an fhuinneog deireadh bliana agus cuirfear na céimeanna go léir i gcrích.  

• Archive Data  - roghnaigh an rogha seo chun sonraí a chartlannú. Ar an mbealach sin beidh tú 
in ann féachaint ar sheansonraí gan seanchóipeanna cúltaca a thabhairt ar ais.   

• Seiceáil go bhfuil na sonraí a thaispeántar ag bun na fuinneoige Deireadh Bliana ceart sula 
roghnaíonn tú an rogha Rith Deireadh Bliana.   

• Roghnaigh TÁ má tá na dátaí Deireadh Bliana ceart.   

• Beidh scáileán dul chun cinn deireadh bliana le feiceáil ansin. Nuair a bheidh sé curtha i gcrích 
fiafrófar díot an mian leat iris Deireadh Bliana a phriontáil. Cliceáil ar ok.  

• Beidh teachtaireacht deiridh le feiceáil le deimhniú go bhfuil an próiseas deireadh bliana 

airgeadais curtha i gcrích, cliceáil ar OK.  

3.f    Sonraí a Sheiceáil Tar Éis an próiseas Deireadh Bliana a Rith   

• Déan comhardú trialach Brought Forward a rith. Roghnaigh Modules > Nominal codes > Trial 
Balance i gcomhair na tréimhse, roghnaigh Brought Forward  

• Deimhnigh nach bhfuil aon chóid ioncaim agus caiteachais ar an tuarascáil sin  

• Ansin, déan do shonraí a sheiceáil arís File > Maintenance > check Data  

• Ar deireadh, déan cóip chúltaca eile de na sonraí agus cuir ‘After Year End’ mar lipéad uirthi 
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• NÁ déan an rian iniúchta a ghlanadh. Má tá sonraí cuntasaíochta le haghaidh níos mó ná dhá 
bhliain ar Sage 50 áfach, agus gur cosúil go bhfuil próiseáil Sage moill mar thoradh ansin ba cheart 
smaoineamh ar an rian iniúchta a ghlanadh. Féach an rannán Sage 50 den suíomh gréasáin le 
haghaidh sonraí maidir leis an bpróiseas sin.  

Tá sonraí iomlána maidir leis an bpróiseas deireadh bliana a rith le fáil in ‘FSSU SAGE Accounts 

Manual -Section 8’   

11. Ba cheart an Buiséad Scoile le haghaidh 2025/2026 a iompórtáil anois chuig Sage 50    

  Tá bileog excel san áireamh i dTeimpléad Buiséid 2025/2026 ar a dtugtar "Sage 50 Import" ina 

dtugtar achoimre ar na cóid ainmniúla agus na figiúirí buiséid iomlána don bhliain.  

Is féidir na sonraí i gColún A, B & D den bhileog seo a chóipeáil isteach i dteimpléad atá ar fáil i 

Sage 50, agus cuirfidh sé seo ar chumas na sonraí buiséid a iompórtáil isteach i Sage 50.   

Féach ar ár suíomh gréasáin anseo chun treoir a fháil maidir leis an bpróiseas. Déan deimhin 

de go bhfuil na cóid ainmniúla céanna ag do theimpléad iompórtála buiséid agus atá i do 

chuntais Sage 50 agus go ndéanfar cóip chúltaca sula ndéantar an fhaisnéis a iompórtáil.   

12. Coigeartuithe iniúchta  

Nuair atá deireadh na bliana rite agat, ba cheart an dáta 31.08.2025 a chur le haon 

choigeartuithe iniúchta ar Chuntais 2024/2025 agus ní ceart iad a dhéanamh ach i leith cóid an 

Chláir Chomhardaithe agus na coigeartuithe Ioncaim agus Caiteachais á mbreacadh agat i gcód 

Cúlchistí Ioncaim 2710.  

13. Comparáidí na bliana roimhe sin  

 Do na scoileanna sin ar mian leo go mbeadh comparáidí idir an bhliain roimhe agus an bhliain 
reatha go dtí seo le feiceáil ina gCuntas Ioncaim agus Caiteachais in ionad na bliana roimhe ina 
hiomláine, tá an tuarascáil roghnach sin mar aon le treoracha maidir lena gcóipeáil isteach in 
Sage 50 le fáil sa chuid Ag tosú le Sage 50 dár láithreán gréasáin.  

14. Oiliúint Sage 50  

Tá roinnt seimineár gréasáin oiliúna beo á reáchtáil againn ó Lúnasa go Deireadh Fómhair chun 

an Treoirlíne seo a fhorlíonadh agus a thacú trí threoir a chur ar fáil maidir leis an gcuntas 

deireadh bliana a réiteach agus a thabhairt chun críche in Sage 50.  

Cuirfidh na seimineáir ghréasáin seo uile leis an soláthar físeán éilimh FSSU do Sage 50 atá ar fáil 

ar ár suíomh idirlín. Chomh maith leis na físeáin Sage, tá rannán feabhsaithe ar ár suíomh idirlín 

(cliceáil anseo) a bhfuil áiseanna éagsúla d’fhíseáin oiliúna ann do phearsanra nua cuntas, rud a 

fheabhsóidh a saineolas ar chuntais scoile a ullmhú.  

https://www.fssu.ie/post-primary/topics/sage-50-accounts/
https://www.fssu.ie/post-primary/topics/sage-50-accounts/
https://www.fssu.ie/app/uploads/2017/07/FSSU-SAGE-Accounts-Manual.pdf
https://www.fssu.ie/app/uploads/2017/07/FSSU-SAGE-Accounts-Manual.pdf
https://www.fssu.ie/app/uploads/2017/07/FSSU-SAGE-Accounts-Manual.pdf
https://www.fssu.ie/app/uploads/2017/07/FSSU-SAGE-Accounts-Manual.pdf
https://www.fssu.ie/post-primary/topics/sage-50-accounts/entering-the-budget-in-sage-50/sage-budget-2/
https://www.fssu.ie/post-primary/topics/sage-50-accounts/entering-the-budget-in-sage-50/sage-budget-2024-2025/
https://www.fssu.ie/post-primary/topics/sage-50-accounts/upgrading-to-sage-50cloud/schools-new-to-sage-50/
https://www.fssu.ie/post-primary/topics/sage-50-accounts/upgrading-to-sage-50cloud/schools-new-to-sage-50/
https://www.fssu.ie/post-primary/training/training-resources-for-new-accounts-personnel/
https://www.fssu.ie/post-primary/training/training-resources-for-new-accounts-personnel/
https://www.fssu.ie/post-primary/training/training-resources-for-new-accounts-personnel/
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Leanfaidh an FSSU le tacaíocht agus oiliúint leanúnach a chur ar fáil le cinntiú go n-úsáideann 

Scoileanna an bogearra chomh maith agus is féidir agus leanfaidh sé de chúnamh a thabhairt do 

scoileanna maidir leis na gnéithe nua atá ar fáil i Sage 50 Accounts. Molaimid, go háirithe, úsáid 

a bhaint as fothaí bainc mar gheall go bhfeabhsóidh sé seo éifeachtúlacht agus tráthúlacht na 

feidhme cuntas, agus ligeann an chianrochtain ar shonraí d’úsáideoirí ceadaithe ó lucht 

bainistíochta na scoile rochtain fíorama a bheith acu ar shonraí airgeadais na scoile.   

  

Teil: 01-269 0677   

info@fssu.ie   

  

An 26 Lúnasa 2025  

  

 

 

Aguisín 1   

Cur Chuige Cuntasaíochta maidir le Deontais/Ioncam Imfhálaithe gan Chaitheamh  

  
Faightear roinnt deontas/ioncam chun críche ar leith, mar shampla an deontas TFC agus an 

deontas maoirseachta agus ionadaíochta. Tugtar deontais imfhálaithe orthu sin. Ba cheart an 

sciar de na deontais sin nach bhfuil caite a chur siar go dtí go gcaithfear é sa scoil.  

  

Ní mór cuntas a thabhairt ar an gcuid sin d’iarmhéideanna deontas imfhálaithe nár caitheadh ag 

deireadh na bliana faoin gcód ábhartha (faoi na cóid ábhartha) (2160-2180) ar an gclár 

comhardaithe i gcairt na gcuntas.   

  

Samplaí de dheontais imfhálaithe iad na deontais seo a leanas.  

  

• Deontas Scéim na Leabhar Scoile Saor in Aisce, deontas Maoirseachta agus Ionadaíochta, 

deontas TFC, deontas Pá Neamh-mhúinteora, deontas Tionlacaithe Bus, deontas Béilí 

Scoile, gach deontas caipitil, etc.  

  

Lean na céimeanna thíos chun cuntas a thabhairt ar na deontais nár caitheadh:  

  

▪ Céim 1: Ríomh méid an deontais nár caitheadh amhail ar an 31.08.2025 (Ioncam Lúide 

Caiteachas).  

  

▪ Céim 2: Déan iontráil dar dáta 31.08.2025 chun an t-airgead nár caitheadh a aistriú chuig 

an gclár comhardaithe.   

  

▪ Céim 3: Déan taifeadadh sa leabhar cúnta dar dáta 01.09.2025 chun an mír gan chaitheamh 

a aistriú ar ais chuig an tuairisc Ioncaim & Caiteachais lena húsáid sa bhliain 31.08.2026. Is 
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féidir an leabhar cúnta seo a thaifeadadh a luaithe is féidir in Sage 50mar tá sé bunaithe ar 

dhátaí. 

  

  Cliceáil anseo le haghaidh bileog oibre chun cabhrú le cuntas a thabhairt ar dheontais gan 

chaitheamh.  

  

https://view.officeapps.live.com/op/view.aspx?src=https%3A%2F%2Fwww.fssu.ie%2Fapp%2Fuploads%2F2025%2F08%2FSample-template-for-manual-reports-VSS-Aug-2025.xlsx&wdOrigin=BROWSELINK
https://www.fssu.ie/app/uploads/2024/09/Calculation-of-unspent-grants-template-2024-Sage.xlsx
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Tábla 1  
Sampla de Chuntas a Dhéanamh ar dheontas gan chaitheamh  

  

  

 

 

 

     Deontas  

Céim 1  Céim 1  Céim 1  Céim 2  Céim 3  

Ioncam  

  

Caiteachas  

  

Iarmhéid an 
Deontais 

amhail ar an  

31.08.2025  

  

Méid gan 
Chaitheamh sa 
Leabhar Cúnta 
amhail ar an  
31.08.2025  

Méid sa Leabhar 
Cúnta amhail ar an  

01.09.2025  

  

Cód 

Ainmniúil  

Méid  Cód 

Ainmniúil  

Méid  Méid  Cód Dr  Cód Cr  Cód Dr  Cód Cr  

Deontas um fheidhmiú 

na heolaíochta (2150) 

 

Costais ghaolmhara 

(1720) 

    22,000 

 

 

2,000 

  2150 

 

 

4390 

3245 

 

 

1720 

Deontas Scéim na 

Leabhar Scoile don 

tSraith Shóisearach 

24/25 

3151 €75,000 4731 €70,000 €5,000 3151 2160 2160 3151 

Deontas Riaracháin do 

Scéim na Leabhar Scoile 

don tSraith Shóisearach 

24/25 

3152 €2,500 4113 €2,000 €500 3152 2160 2160 3152 

Deontas Scéim na 

Leabhar Scoile don 

tSraith Shinsearach 

24/25 

3150  €9,600  4730  €8,900  €700  3150  2160    

Deontas le haghaidh 

Maoirseacht agus 

Ionadaíocht  

3240  €5,130  4150  €4,200  €930  3240  2170  2170  3240  

Deontas Caipitil faoi 

chomhair Leabhair don 

Leabharlann Scoile  

3155  €15,000  4641  €1,000  €14,000  3155  2161  2161  3155  

Deontas i gcomhair 

Coimhdirí Bus  

3294   4196     3294  2171  2171  3294  

DSP Béilí Scoile  3296   4912     3296  2171  2171  3296  

Straitéis 

Dhigiteach/Deontas TFC 

(Neamhchaipiteal)  

3230  €27,500  4410  €17,500  €10,000  3230  2165  2165  3230  

Straitéis 

Dhigiteach/Deontas TFC 

(Caipitiúil)  

3921  €27,500  1461  €17,500  €10,000  3921  2165  2165  3921  

Deontas Roinnte 

Digiteach (Neamh-

chaipitiúil)  

3230  €20,000  4410  €17,500  €2,500  3230  2179  2179  3230  
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Deontas Roinnte 

Digiteach (Caipitiúil)  

3921  €20,000  1461  €17,500  €2,500  3921  2179  2179  3921  

Deontas Caipitil: 

Foirgníocht  

3900  €90,000  3940  €80,000  €10,000  3900  2171  2171  3900  

Deontas Caipitil: 

Trealamh  

3920  €25,000  1421  €20,000  €5,000  3920  2171  2171  3920  

 

 


